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Developments magazine is the “voice of the timeshare industry” with the American Resort 
Development Association (ARDA) in Washington, D.C. The association, founded in 1969, also 
maintains strategic alliances with counterparts in Australia, Canada, Europe, the Caribbean and 
Latin America, Mexico, and South Africa. Developments speaks not only to the industry but also for 
the industry to its various constituencies—legislators, regulators, academics, financial analysts, 
sister organizations, and the media.

First published in 1978, Developments analyzes industry trends in timeshare, resort, and 
community developments. In each issue, you will find insightful articles on matters that directly 
affect you, your professionalism, your growth and ultimately, your bottom line. 

Developments is a forum for the industry to express ideas and concerns and to address the 
constant changes in the industry. The ARDA membership represents the key players in today’s 
resort development industry. Developments is your magazine.

Developments is published 10 times a year, which includes the double annual ARDA World 
Convention and ARDA Fall Conference issues. It includes useful information on marketing, 
finance, sales, design, resales, public relations, community development, international issues, 
vacation clubs and points systems, management, and regulation.

In 2009, Developments went digital, allowing our readers access to the magazine online and 
in print. By increasing the circulation and adding an interactive interface, Developments is the 
destination for advertisers looking to reach the vacation ownership industry.



ARDA promotes the growth and development of the 		
timeshare industry through a variety of capacities:

Advocacy
Actively involved in local, state, 	
and national governmental 
affairs, ARDA monitors 
regulatory issues that affect 
timeshare. ARDA actively 
engages in lobbying efforts 
focused on the establishment 	
of a legislative environment that 
fosters industry growth and 
further enhances consumer 
confidence and protection.

Networking
ARDA offers industry 
professionals educational 	
and networking opportunities 
through its annual ARDA 
Convention and Exposition, 	
the ARDA Fall Conference, 
committee meetings, and a 
variety of regional educational 
seminars offered each year.

Business 
Partnerships/
Bridge-Building
Through alliances with 
organizations in related and 
complementary industries in 
North America and overseas, 
ARDA pursues business and 
growth opportunities on behalf 
of its members.

Outreach
ARDA reaches out to myriad
audiences with news of the 
bright future and positive 
economic impact of the 
timeshare industry and the 
increasingly diverse and 
attractive vacation ownership 
opportunities now available 	
to consumers.

Knowledge
Through a variety of 
informational tools, including 
published research summaries, 
news updates and e-mail alerts, 
Developments magazine, and 
its website, ARDA shares 
market intelligence and keeps 
its members informed of 
industry trends and current 
events.

Support and 
Development
The ARDA International 
Foundation (AIF) offers 
professional and educational 
development through 
publications covering the 
industry’s ethical, legal, 
regulatory, and operational 
intricacies; study courses; tests 
that assess industry knowledge; 
and recognition of continuing 
educational efforts.
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The American Resort Development Association (ARDA) is the Washington, D.C.-based 
professional association representing the vacation ownership and resort development 
industries. Established in 1969, ARDA has members in over 30 countries ranging from 
privately held firms to publicly traded companies and international corporations with 
expertise in shared ownership interests in leisure real estate. The membership also 
includes timeshare owner associations (HOAs), resort management companies, and 
owners through the ARDA Resort Owners Coalition (ARDA-ROC).

The American Resort Development Association

For more information about ARDA, visit the website at www.arda.org
or contact the association headquarters at (202) 371-6700.

Overview



The timeshare 
industry
•	 1,548 resorts in the 		

United States

•	 Most resorts
		  Florida (23%)
		  California (8%)
		  South Carolina (7%)

•	 $6.4 billion U.S. timeshare 
sales volume in 2010

•	 $19,308 the average price	  
for a week of timeshare use 	
in the U.S. in 2010

•	 $731 per week of annual use 
is the average maintenance 
fee in the U.S. (weighted)

•	 8.1 million timeshare 		
intervals owned in the U.S.

•	 197,668 timeshare units 	
in the U.S.

•	 128 units is the average 	
size of a timeshare resort 	
in the U.S.

About today’s 
owners
•	 Average age is 52 years

•	 80% are married or have 
domestic partners

•	 92% own their home

•	 $78,400 is the median 
household income

•	 57% are college graduates 	
or hold a graduate degree

Purchase motivation
Why buy timeshare?
•	 Certainty of quality 

accommodations

•	 Location of the resort

•	 Save money on future 
vacation costs

•	 Opportunity to exchange 	
with other resorts, internally 
and externally

Satisfaction rates
Among U.S. timeshare owners:

•	 About 84% indicate 
satisfaction with their 
timeshare experience

•	 69% would recommend 	
their home resort to 		
friends and families

•	 58% would recommend 
timeshare in general

Owner use
•	 48% use their time

•	 24% exchange

•	 13% rent to others

•	 13% give their week to 	
a friend or family member

•	 26% bank for future use
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The timeshare industry

Sources: American Resort Development Association: State of he Vacation Timeshare Industry: 					   
United States Study, 2011 Edition and Shared Vacation Ownership Owners Report, 2010 Edition

Turn your ad 
into an interactive 

experience. 

Contact Joel Nepomuceno,
jnepomuceno@arda.org, 

for more information.
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Brand building
Brand building is one of the most important tools in a marketing strategy. Customers who identify 		
with a brand are more likely to recommend a specific product and be repeat buyers.

Comprehensive market share
ARDA membership consists of 95 percent of the domestic timeshare industry. Utilize Developments 
advertisements to increase your exposure and deliver your message to the vast majority of the 	
timeshare industry constituents. 

Editorial for decision makers
Advertising in Developments magazine is a cost-effective, budget-efficient way to reach all industry 
leaders when they are looking for fresh ideas, best practices, and the latest industry news. The editorial 
material is written by timeshare industry leaders for timeshare industry leaders. Columns and articles 
come from peer-selected association members and business experts and include the innovative and 
authoritative ideas presented at ARDA seminars, workshops, and ARDA International Foundation 		
(AIF) meetings. 

Quality circulation
All subscriptions are paid, renewed within one year and in the name of an individual. No bulk subscriptions 
by title or department. BPA audit pending. Publishing schedule is monthly with double issues for the spring 
ARDA World Convention and ARDA Fall Conference. Bonus distribution includes all registered attendees 
at the ARDA World Convention and ARDA Fall Conference.

Contents
Developments reports on news and tracks trends around the vacation ownership industry today—the 
development, financing, marketing, and management of timeshare vacation ownership resorts, mixed-
use projects, and more. Articles cover products, services, and technology of interest to the industry; the 
activities of prominent individuals and companies; environmental and operational issues of property 
management and development; and member profiles and informative discussions with leaders on a 	
broad spectrum of topics relating to the fastest-growing segment of the hospitality industry.

Feature article
In-depth information or discussions with industry leaders cover a broad spectrum of topics.

Columns
Articles on sales, marketing, resort management, technology, industry innovations, finance, human 
resources, public relations, legal and regulatory issues, architecture and design, fractional ownership, 
education and other vacation ownership-related business issues.

Departments
•	 Case Study

•	 International

•	 Success Spotlight

•	 Education

•	 Letter from ARDA’s Chairman, 
Dan Harrill, Holiday Inn Club 
Vacations

•	 Advocacy

•	 Member Profile: informative 
discussions with industry 
leaders in a question-and-
answer format

•	 Briefs and People: news, 
notes and upcoming events 
from around the industry

•	 ARDA’s President & CEO, 
Howard Nusbaum, covers a 
variety of issues and concerns 
related to vacation ownership

•	 State Affairs

•	 Industry News

•	 VIP Listings

•	 Foundation/Research

•	 Owners

•	 Technology

•	 Construction & Design

Why advertise?
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The top decision makers in 
the resort and community 
development industry 
read Developments 
and are exposed 
to—and influenced 
by—its professional 
advertisements.

Target industry professionals

Developments magazine is 
the only place your advertising 
reaches every prospect at 
once. ARDA members represent 
approximately 95 percent of the 
domestic timeshare market and, 
along with its global alliance partners, 
three-quarters of the $9 billion world 
vacation ownership market.

Reach your market

•	 57% of readers visit an advertiser’s 
website as a result of seeing an ad.

• 	22% have called, e-mailed, 	
or wrote an advertiser directly.

•	 18% recommend purchasing 	
an advertised product/service.

•	 11% have purchased an 
advertised product/service.

Action taken after reading
Developments*: •	 46% of readers approve/

authorize the purchasing of 
products/services.

• 	20% recommend/specify the 
purchase of products/services.

• 	6% research products/
services to buy.

Role in purchasing?*

Audience profile

Distribution

13%
Other Goods,

Services

14%
Exchange

35%
Developers

4%
Property

Management
Operations

5%
Sales, 

Marketing

6%
Legal, 

Regulatory

12%
HOA, POA Officers/

Board Member

12%
Financial
Services

Make your ad 
come to life with 
flash animation. 

Go to page 6 for 
more information.

Total reach: Developments reaches 3,000 subscribers both international 
and domestic, with an average pass-along rate of 3. Developments is 
also distributed at many industry-related events each year.

*Source: Developments Magazine 2007 Readership Survey
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Rates & specifications 2012

Bleed ads  Keep live matter 0.4375” from gutter and trim edges.

Printing and binding  Offset lithography, saddle-stitched 

1/3 page vertical 
2.3125 x 9.875”

1/3 page square 
4.75 x 4.75”

1/6 page vertical 
2.3125 x 4.75”

1/6 page horizontal 
4.75 x 2.25”

1/2 page horizontal 
7.375 x 4.75”

2/3 page vertical 
4.75 x 9.875”

Double page bleed 
17.125 x 11.25”

Full page bleed 
8.375 x 10.875” 

plus 0.125” border for bleed

Full page 
7.375 x 9.875”

Double page cross-over gutter bleed 
15.75 x 9.875”

For more information, 
contact:
Joel Nepomuceno
Manager, Industry Sales
(202) 207-1074 direct
jnepomuceno@arda.org

Non-members add 15%

Price protected during the 
term of the contract

Frequency Discounts:
Frequency rates are 
determined by the number 
of insertions appearing 
within a calendar year. 
Advertising schedules 
composed of mixed space 
units are entitled to frequency 
discounts. A spread is 
counted as two insertions 
toward a frequency rate.

		  Convention 
Four color	 Issue Only	 1x	  3x	  5x	 10x	 20x

	 Full Page 	  $3,800	 $3,110 	 $2,915 	 $2,750 	 $2,545 	 $2,390

	 2/3	 $3,190 	 $2,655 	 $2,500 	 $2,320 	 $2,160 	 $1,990

	 1/2 	 $2,650 	 $2,200 	 $2,075 	 $1,945 	 $1,735 	 $1,575

	 1/3 	 $2,090 	 $1,745 	 $1,635 	 $1,555 	 $1,420 	 $1,310

	 1/6 	 $1,725 	 $1,400 	 $1,320 	 $1,235 	 $1,130 	 $1,080

Guaranteed Positions

	 Inside Front Cover 	 $4,280	  $3,565 	 $3,340 	 $3,180 	 $2,920 	 $2,740

	 Inside Back Cover	 $4,110	 $3,480	  $3,260 	 $3,095 	 $2,850 	 $2,675

	 Back Cover 	 $4,365	 $3,650 	 $3,420 	 $3,225 	 $2,975 	 $2,785

	 Preferred Page 	 $3,915 	 $3,400 	 $3,220 	 $3,040 	 $2,800 	 $2,630

	 Gate Fold 	 $7,500 	 $5,000
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Editorial calendar 2012

	 January	 Outlook/State of the Industry
		  Articles due . . . . . .      November 4, 2011
		  Ads close . . . . . . .      November 18, 2011
		  Ad art due . . . . . .      November 30, 2011

	 February	 2012 Convention Preview
		  Articles due . . . . . .      December 2, 2011
		  Ads close . . . . . . .      December 16, 2011
		  Ad art due . . . . . .      December 29, 2011

	 March 	 International
		  Articles due . . . . . . . .        January 5, 2012
		  Ads close . . . . . . . . .        January 13, 2012
		  Ad art due . . . . . . . .        January 31, 2012

	 April/May	 ARDA World Convention Issue  
		  Product Innovations
		  Articles due . . . . . . .       February 3, 2012
		  Ads close . . . . . . . .       February 10, 2012
		  Ad art due . . . . . . .       February 17, 2012

	 June	 ACE Project of Excellence 
		  & Convention Highlights
		  Articles due . . . . . . . . . .           April 4, 2012
		  Ads close . . . . . . . . . . .            April 13, 2012
		  Ad art due . . . . . . . . . .           April 30, 2012

	 July	 Architecture, Construction 
		  & Design
		  Articles due . . . . . . . . . . .           May 2, 2012
		  Ads close . . . . . . . . . . . .           May 18, 2012
		  Ad art due . . . . . . . . . . .           May 31, 2012

	 August	 Recreation & Amenities
		  Articles due . . . . . . . . . .           June 1, 2012
		  Ads close . . . . . . . . . . .            June 15, 2012
		  Ad art due . . . . . . . . . .           June 29, 2012

	 September	 Resort Management/ 
		  Operations/HOAs
		  Articles due . . . . . . . . . . .           July 2, 2012
		  Ads close . . . . . . . . . . . .           July 13, 2012
		  Ad art due . . . . . . . . . . .           July 29, 2012

	 October	 Law & Finance
		  Articles due . . . . . . . . .         August 2, 2012
		  Ads close . . . . . . . . . .         August 17, 2012
		  Ad art due . . . . . . . . .         August 31, 2012

	 November/	 Fall Conference Issue 
	 December	 Technology/Innovations
	 	 Articles due . . . . .      September 3, 2012
		  Ads close . . . . . .       September 14, 2012
		  Ad art due . . . . .      September 28, 2012

ARDA World Convention
Americas Lodging Investment Summit (ALIS)

ARDA World Convention
ARDA Trustee Retreat
CRDA Convention
Ragatz Associates Fractional Interest Conference

ARDA World Convention
 

ARDA Northeast
ARDA Trustee Retreat

ARDA Northeast 2013
ARDA Southeast
ARDA West

ARDA Northeast 2013
ARDA Southeast
ARDA West

ARDA Northeast 2013
ARDA Southeast
ARDA West
Shared Ownership Investment Conference (SOIC)

ARDA Fall Conference

ARDA Fall Conference

 

Deadlines Bonus Distributions

For complete advertising contract terms and conditions, please visit the ARDA website www.arda.org.



Generating leads has never been so easy. Now, with digital version of Developments, you can track 
your ad activity by seeing the number of “click-throughs” and the average length of time readers stay on 
your page. Choose to include an AdGen (like a reader-response card) to your advertisement and gather 
demographic information to ensure future sales. The information gathered by the AdGen will be sent 
directly to you.

Lead generation

Looking to increase your traffic activity on your company’s website? Follow the leads you will 
receive through Developments. All digital ads will include an embedded link of the advertiser’s 
website for free. ARDA will provide a detailed analysis of your ad traffic for each issue.

Traffic activity

Expand the size of your print ad campaign through the new digital Developments! The electronic version 
can be forwarded among ARDA member companies at a much faster rate than the traditional print 
edition’s pass-along rate,* making it easy for the purchasing managers and resort property managers 
to receive the magazine and view your ad.

Expanding your target reach

*Based on the Developments Magazine 2007 Readership Survey

Bring your ad to life with our new interactive features:

•	 Fading Links $150		

	 Use fading links in any color to draw 
attention to live Web links in your ad.

•	 Flash Animation $500	

	 Enhance your print ad by providing your 
own flash animation to ARDA’s designers 
OR have our designers create simple 
animation effects to give your digital ad 
an added boost.

•	 Custom Flash Animation $750
	 Turn your static print ad into an 	

attention-grabbing, animated message 	
by having ARDA designers transform 
your ad into its own interactive 
experience.

All advertisers will be able to upgrade their print ad to an electronic one in the new digital 
Developments, at no additional cost. Re-use your current ad campaign or add rich media/ 
animation to bring your ad to life. Allow your prospects to interact with your ad, sending them 
straight to your website. Online advertising combined with print advertising creates a great 
tool for both branding and new lead generation.

•	 GateFold $750		

	 Only available for two-page spreads 
running in the print edition.

•	 Audio Ads $900		

	 Add music or sound clips to your ad.

•	 Video Ads $1,000
	 Incorporate video in your ad. Several 

player options available for easy 
customization.

Need New or Updated Video Clips?

ARDA member firms can produce quality materials for use
on your website, in Developments ads, and a host of other
marketing opportunities. Contact Joel Nepomuceno at
202-207-1074 for more information, or see the ARDA 	
Resort Buyer’s Marketplace at www.arda.org/marketplace.
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Online advertising
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•	 Background logo

•	 Landing page (Left opening page)

•	 Welcome verbiage “Digital Developments presented by”

Presenting Sponsor $5,000

Become a Developments sponsor

Don’t just advertise within Developments magazine. Be a sponsor! By sponsoring the digital 
edition of Developments, you are supporting ARDA and the new electronic format. As a 
sponsor, your company logo will be the first thing that readers will see when they open the 
magazine electronically and will be maintained during the entire viewing time.

A video link can 
turn your print ad into 
a customer testimonial 

or product
demonstration.
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A consistent advertising program in Developments is the most effective and economical way 
of ensuring professional exposure for your products and services to this growing and lucrative 
market. Online advertising offers a combination of cost-effectiveness, highly targeted marketing, 
and unmatched tracking capabilities.

Get your name out

Add a blow-in card, a belly band, or AdGen (a reader response card), 
to the print or digital Developments. Contact Joel Nepomuceno at 
jnepomuceno@arda.org or (202) 207-1074 	for more information.

Interested in out-of-the box marketing opportunities?

Other marketing opportunities

Advertising in either of the ARDA World publications, or the three convention-focused editions 
of Developments, is a great way to get that recognition! The On-site Program, Attendee List/
Industry Phonebook, and the convention issue of Developments are each made available at 
the registration center and throughout the convention’s key function spaces.

Ad Size	 Rate
Full page	 $2,300
2/3 page	 $2,000
1/2 page	 $1,800
1/3 page	 $1,300
1/6 page	 $900
All ads are 4-color process.

Ad Size	 Rate
Full page	 $2,300
2/3 page	 $2,000
1/2 page	 $1,800
1/3 page	 $1,300
1/6 page	 $900
All ads are 4-color process.

Ad Size	 Rate
Full page	 $8,745
2/3 page	 $7,500
1/2 page	 $6,225
1/3 page	 $4,905
1/6 page	 $3,960
All ads are 4-color process.

Package Deals—exclusively for Exhibitors and Sponsors

Combine the Developments package with the On-site Program Guide 
or the Attendee List/Industry Phonebook and take 20% off the total.

Advertise in all five publications and take 25% off the total.

Attendee List/Industry Phonebook

The greatest longevity of any ARDA publication 
the—‘phonebook’ that sits on industry professionals’ 
desks all year long. Ads Close: January 31, 2012.

The On-site Program

The most referred-to publication at ARDA World, 
with all the information for the educational sessions, 
special events, exhibit hall, speaker listing and more. 
Use your ad to draw traffic to your booth by including 
your booth number. Ads Close: January 31, 2012.

Developments Package

•  February 2012 Convention Preview
•  April/May 2012 Convention Issue
•  June 2012 Convention Wrap-up

See the Developments rate card for rates.
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Submit articles
Writing for Developments is an excellent opportunity for 
industry professionals to share their expertise, gain peer 
recognition, and better their industry. All ARDA members 
are invited and encouraged to submit articles. This is a 
prime opportunity to articulate your views and expose 
readers to you and your company. Submissions are 
reviewed by the editorial board for objectivity, relevance 
and value to the membership. We expect the journalistic 
standards of accuracy and fairness to be observed.

Participants in the AIF Registered Resort Professional 
(RRP) and Associate Resort Professional (ARP) 
designation programs may earn up to two credits towards 
their designation by contributing substantive articles to 
Developments magazine. A maximum of one-half credit 
will be given for each published article. This is an excellent 
opportunity for experienced industry professionals to share 
their expertise, gain peer recognition and earn AIF credits 
at the same time.

Spread the word
Developments spreads the word about your 
accomplishments and successes. “Around the Industry” 
details company news and announces personnel 
promotions and additions, as well as personal 
accomplishments, such as awards and service recognition. 
We urge you to send us your news to keep the entire 
industry abreast of your accomplishments. Materials must 
generally be received two months prior to the first day of 
the issue’s cover month to be considered for that issue. 
However, due to space constraints, not all material can be 
published in the next available issue. 

Make Developments a tool for you—a tool which helps 
you learn and grow from other industry professionals, 
disseminate your information, and continue your personal 
growth through one of ARDA’s many membership benefits.

Word count page-equivalence
Please use the following parameters for determining page 
equivalence:
900 words + no graphic = 1 page*
700–750 words + headshot = 1 page†
500 words + headshot and standard graphic = 1 page‡

*	Developments magazine is a 3-column/page publication, and each 
column comprises up to 300 words. Please note, however, that no all-
text pages will be published: it’s the publisher’s expectation that every 
page will include some graphic interpretation of the copy, be it a sidebar, 
headshot, photo, graph or other illustration.

†	All bylined articles must also include a brief (40 words or less) 
biographic blurb.

‡	Graphic sized between 2x3 and 4x5.

Share your knowledge

Author guidelines
1. 	 ARDA retains the right of acceptance or rejection 	

and the right to edit any submissions.

2. 	 ARDA does not endorse commercial products, 
services, or individuals offering services within the 
resort industry. Articles should reflect this objectivity 
and encourage learning of techniques rather than 
publicizing certain commercially available products 		
or services.

3. 	 Developments’ audience consists of professionals in 
the vacation ownership industry. The level of difficulty 
of articles should be set accordingly with specific, 
concise, and accurate information.

4. 	 Occasionally, the editor and ARDA editorial board 
determine that articles submitted do not meet 
association publication and editorial standards. 		
In these cases, every attempt is made to provide	  	
a review process to assist in article revision.

5. 	 ARDA generally publishes only original manuscripts 
that have not been published in other mediums. 	
Author warrants text and illustration copyrights.

6. 	 You are encouraged to discuss your topic idea 	
with the editorial staff prior to article submission.

7. 	 Publication of an article after the manuscript 	
deadline cannot be guaranteed.

8. 	 Length may range from 800 to 2,500 words and will 
depend on subject and discussion with editorial staff.

9. 	 Black and white or color artwork to accompany 	
the article may be submitted.

10. 	Include your name, company name, address, 
telephone, and business title with your article. 	
Include three to four sentences of biographical 
information about yourself and/ or your company. 
Include a high-resolution headshot photo.

11. 	Articles should be typewritten, double-spaced 	
and submitted preferably as an MS Word 		
document via e-mail.

Discuss
Developments 

story ideas with 
Kathryn Mullan, Editor

(202) 207-1075
kmullan@arda.org
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Quality is a priority for Developments, and we review all artwork submitted to guarantee that each 
issue best represents your organization and the vacation ownership industry. To help us maintain 
that high standard, please read and follow these guidelines.

Developments Advertising Artwork Preparation

File formats and media

General 
Guidelines
•	 Create your layout to the  

exact dimensions of the 
reserved ad size.

•	 For ads that bleed, keep 
all important copy and art 
work 7/16” away from the 
page edges. Bleed artwork a 
minimum of 1/8” and output 
with crop marks. Non-bleed 
ads do not need crop marks.

•	 Place images and artwork 
into your layout at 100% of 
size with a resolution of 300 
dpi (dots per inch) or those 
created as vector art. This 
maintains image sharpness 
and detail.

•	 Use only CMYK images in 
your layout. RGB images will 
not render color accurately 
when printed. Spot colors will 
be reproduced as CMYK.

•	 Use Adobe Photoshop to 
convert RGB images to CMYK 
with a destination profile of 
U.S. Web Coated (SWOP) v2. 
Go to Edit > Convert to Profile. 
Then select the profile “U.S. 
Web Coated (SWOP) v2” in 
the Destination Space box. 
Save the change.

•	 Convert spot colors to CMYK 
before exporting or saving 
as a PDF file. The PANTONE 
Color Bridge should be used 
to assign CMYK values to 
convert spot colors. Software 
programs may not convert 
spot colors consistently and 
color shifting can occur.

•	 When available, pre-flight your 
file before exporting or saving 
your PDF file. This will indicate 
any items that may adversely 
affect print quality.

Please submit advertisement artwork as PDF/X1-a files. PDF/X-1a is a standard ISO file 
format used to reliably exchange final print-ready ads and pages. Design software 
programs such as the Adobe CS Suite (InDesign, Adobe Illustrator, Adobe Photoshop) 
and QuarkXpress allow for exporting or saving to PDF/X-1a files. Avoid using non-design 
desktop programs such as Microsoft Word and PowerPoint.

Creating PDF/X-1a Documents
Instructions for creating PDF/X1-a files are below. These guidelines help to ensure color and layout 
accuracy when printed. If color is critical, it is highly recommended that a match print be submitted 
to establish quality control standards.

Adobe InDesign
1.	 Go to File > Export and select Adobe 

PDF in the Format menu.
2. 	 In the Adobe Export PDF dialog box, 

select High Quality Print in the Adobe 
PDF Preset menu and PDF/X1-a:2003 
in the Standard menu. This converts 
the resolution and color designations to 
their proper settings. Review those in 
the feature selections listed on the	
left side of the dialog box.

	 Compression
	 Bicubic Downsampling should be 		

set to 300 pixels for all images.

	 Output
	 Color Conversion: Convert to Destination    

(Preserve Numbers)
	 Destination: Document CMYK-U.S. 
	 Web Coated (SWOP) v2
	 Output Intent Profile Name: Document
	 CMYK-U.S. Web Coated (SWOP) v2

3.	 For ads that bleed only: 
	 Under Marks and Bleeds in the left-hand 

feature listing, select All Printer Marks and 
use Document Bleed Settings. Enter a 
minimum bleed area of 0.25” for all four 
page sides.

Adobe Photoshop
1.	 Go to File > Save As and select Adobe 

PDF in the Format menu.
2. 	Follow the instructions above for step 2.
3. 	For ads that bleed only:
	 We recommend placing your artwork in a 

design layout program such as InDesign or 
QuarkXpress. Crop marks and bleeds will 
have to be manually created in Photoshop 
PDF files. Allow for a minimum bleed area 	
of 0.25” for all page sides and add 1/2” 	
crop marks.

Adobe Illustrator
1.	 Go to File > Save As and select Adobe 

PDF in the Format menu.

2. 	Follow Adobe InDesign instructions for 
steps 2 and 3.

	 Note: In the Compression features, all images 
will be indicated as Do Not Downsample

QuarkXpress
Files created using QuarkXpress 6.0 or earlier 
should be printed as Postscript files and converted 
to PDF/X-1a file using Acrobat Distiller. Files created 
using QuarkXpress 7.0 can be exported to PDF/
X1-a files accurately directly within the program.
QuarkXpress 6.0 or earlier:
1. 	Go to File > Print. In the print dialog box, under 

Setup, set the Printer Description to Adobe PDF. 
Other features should follow these settings:

	 Output: Bleed
	 Print Colors: Composite CMYK Bleed Type
	 Halftoning: Conventional Symmetric
	 Resolution: 2400dpi Amount: 0.25”
	 Frequency: 133lpi

2. 	Click Print, then use the following 	
settings in the Print dialog box.

	 Output options:
	 Select Save as > File, Format: Postcript
	 Printer Feature:
	 Resolution: 2400dpi
	 Save and name the postcript file.

3. 	Open Acrobat Distiller. Under Default 	
Settings, select PDF/X1-a:2001. Drag and 	
drop the postscript file into the Distiller window. 

QuarkXpress 7.0:
1. 	Export to a PDF file. Select PDF/X1-a 		

in the Verification menu.
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Animation 
•	 Supply animation as Flash 7 or earlier files. 	

We will need .swf AND .fl a files supplied. 
	 *Please note that we cannot use Flash 8 files.

•	 We do not support animations created using 
SWiSH.

•	 Make sure there is no white space around 	
the edge of the Flash animation.

•	 Set the Flash file to a frame rate of 24 fps.

•	 For animations that shouldn’t loop, please 
ActionScript it as such.

•	 Avoid any ActionScript that can affect the 
Nxtbook engine, such as the _parent layer of 	
the animation, _level0 and _root references, 		
or global functions like setTimeinterval.

•	 Animations need to be created for display 		
at the maximum zoom size.

•	 The normal maximum zoom size is 950 pixels 
wide, but if the maximum zoom size is made 
larger or smaller, we will then provide different 
dimension for the Flash animations accordingly.

•	 Animations created for the intro page, opposite 
the cover, should be made at 852x1050 pixels 		
or dimensions that are proportional.

•	 There should be no links in the animations we 
are given. We will create the links so they can 	
be tracked.

•	 There is no file size limit on animations, but for 
loading purposes, the files should be as small 	
as possible.

•	 Images should be set to lossless compression 
instead of photo compression.

•	 Filenames for Flash animation files (SWFs) 
should not include special characters such as 
brackets, question marks, quotes, commas, etc. 
Underscore characters are OK to use.

•	 Do not use any preloading process in the 
animations. 

Audio
•	 Send audio files embedded in a Flash document. 

We also accept .mp3 or .wav files.

•	 .mp3 files should be set at a sample rate of 
11kHz, 22kHz, 44kHz or 96kHz.

Video
•	 Send video files as an .flv or .avi file. We 

also accept Windows Media Player, Real 
Video or QuickTime formats.

•	 When sending QuickTime video files, please 
avoid using these video codecs: Intel Indeo 
Video and SoftDV. The recommended video 
codecs for QuickTime are:

		  o Uncompressed video
		  o Sorenson Video 1, 2, and 3
		  o Motion JPEG A and B

•	 When sending QuickTime video files, 	
please avoid using the IMA 4:1 audio codec. 
The recommended audio codecs 		
for QuickTime are:

		  o Uncompressed audio
		  o ALaw 2:1
		  o ADPCM

•	 When sending .avi files, avoid using 		
the Intel Indeo video codec.

Rich media specifications

Don’t let 
print advertising 
limit your ads.

Contact Joel Nepomuceno,
jnepomuceno@arda.org, 

for more information.
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Billing and payment terms
Brand building is one of the most important tools 
in a marketing strategy. Customers who identify 
with a brand are more likely to recommend a 
specific product and be repeat buyers.

Commissions
Advertising agencies may take 15% of gross 
billing on rate, provided that the account 
is paid within 30 days of invoice date. To 
qualify, advertising agencies representing a 
Developments client must submit a request on 
agency letterhead, which includes their separate 
and distinct company name, principal contact 
person, and mailing address. No commission 
is allowed on the cost of artwork, conversion 
charges, reprints, mechanical changes, or 
classified advertising charges.

After publication
Materials will be stored for six months and then 
destroyed unless written instructions to the 
contrary are sent to the Editor.

Short rates and rebates
Advertisers will be short rated if, within a 12-month 
period from the date of the first insertion, they do 
not use the amount of space upon which their 
billings have been based. Rate rebates will be 
made if the advertiser exceeds the amount of 
space contracted within 12 months to earn a 	
lower rate than that at which they had been billed.

Advertising regulations, 	
terms, and conditions
All other regulations, terms, and conditions 		
are in the advertising contract.

Disclaimer
Advertiser and advertising agency assume 
liability for all content of advertisements printed, 
including names, portraits, text, representations 
or any sketch, map works, labels, trademarks, 
or other copyrighted matter. The publisher 
reserves the right to reject or cancel any 
advertisement for any reason at any time or to 
add the word “advertisement” at the bottom of 
any advertisement which too closely resembles 
Developments’ editorial pages. ARDA has 	
specific policies regarding the representation 	
of non-member firms and organizations.

General regulations
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1.	 Advertising agencies may take 15% of 
gross billing on rate provided account is 
paid within 30 days of invoice date. To 
qualify, advertising agencies representing 
a Developments client must submit a 
written request on agency letterhead, 
which includes a separate and distinct 
company name, principle contact person, 
and mailing address from the agency’s 
client Advertiser. No commission is 
allowed on the cost of artwork, conversion 
charges, reprints, or mechanical changes. 

2. 	 Materials will not be returned to Advertiser 
unless specifically requested. Materials will 
be discarded after six months. 

3. 	 Payment with order except for ARDA 
members, who may receive 30-day terms. 
Payment in full is due within 30 days of the 
initial invoice date. Advertising privileges 
will be suspended on accounts over 90 
days past due. All expenses and legal fees 
incurred in collecting outstanding invoices 
will be paid by the Advertiser. The 
American Resort Development Association 
(ARDA) reserves the right to require 
payment in advance of publication. 

4. 	 Advertiser shall submit to ARDA all 
advertising and editorial materials not later 
than 45 days prior to publication. 
Alterations requiring additional work will be 
charged at current rates. When no other 
copy is provided by Advertiser by the 
closing date, ARDA may insert previous 
advertisement from Developments 
magazine. Insertion orders are binding 
after closing dates. Advertisers canceling 
after this date will be billed for space 
ordered. 

5. 	 ARDA reserves the right to reject any 
advertisement at any time after receipt of 
proof of text, copy and/ or illustrations, 
even though a prior similar order may have 
been approved. ARDA shall have the right 
to omit any advertisement when the space 
allotted to advertising has been filled. 
Unintentional or inadvertent failure to 
publish advertising invalidates the insertion 
order for that issue only. Failure of ARDA 
to insert any advertisement shall be 
considered immaterial and shall not 
constitute a breach of this Agreement, nor 
shall ARDA be liable for damages thereof. 
In such event, Advertiser shall have the 
option of having such advertisement 
printed in a future issue under these Terms 
and Conditions or of having no charge for 
such advertisement not inserted. 
Advertisements already run shall be paid 
for at rates in the Rate Card. ARDA 
reserves the right to require any 
advertising to be labeled “advertisement.”    

6. 	 ARDA shall not be liable for any damages 
for failure to fulfill an order for any reason 
whatsoever, including but not limited to 
labor disputes, strike, war, riot, 
insurrection, civil commotion, fire, flood, 
accident, storm, act of God, or any other 
circumstances. In such event, the 
Advertiser’s sole remedies shall be those 
in paragraph five above. 

7. 	 Any specification or order for the use or 
non-use of any particular page or position 
where the advertisement is to be inserted 
shall be treated as a request only, and 
ARDA shall not be obligated to comply 
with said request. In the event said request 
for position is granted, Advertiser shall pay 
an additional position charge. 

8. 	 Any taxes which may be imposed on any 
advertising shall be advanced by ARDA on 
behalf of Advertiser, be billed to Advertiser 
and be due and payable immediately. 

9. 	 ARDA reserves the right to cancel this 
Agreement at any time upon Advertiser’s 
failure to pay any bill when due. 

10. In the event ARDA must employ an 
attorney to collect sums due or to enforce 
compliance by Advertiser with any of the 
terms of this Agreement, Advertiser shall 
pay to ARDA attorney’s fees and other 
costs incurred by ARDA in connection with 
any legal actions and appeals thereof. 

11. Advertisers will be short rated if, within a 
12 month period from the date of the first 
insertion, they do not use the amount of 
space upon which their billing has been 
based. 

12.	Advertiser shall indemnify ARDA and hold 
ARDA harmless from any and all loss, 
cost, expense and damages on account of 
any and all manner of claims, demands, 
actions and proceedings that may be 
instituted against ARDA on grounds 
alleging that any advertisement submitted 
hereunder by or on behalf of Advertiser 
violates any copyright or any proprietary 
right of any person, or that it contains any 
matter that is libelous or scandalous, or 
invades any person’s right to privacy or 
other personal rights. Advertiser agrees at 
Advertiser’s own expense, to promptly 
defend and continue the defense of any 
such claim, demand, action or proceeding 
that may be brought against ARDA, 
provided that ARDA shall promptly notify 
Advertiser with respect thereto. The 
Advertiser shall reimburse ARDA for any 
amount paid by ARDA in settlement of 
claims or in satisfaction of judgments 
obtained by reason of publication of such 
advertising copy, together with all 
expenses incurred in connection therewith, 
including but not limited to, reasonable 
attorney’s fees and court costs. 

13. 	This writing contains the entire Agreement 
of the Parties. No representations were 
made or relied upon by either party, other 
than those expressly set forth in this 
Agreement. No agent, employee or other 
representative of either party is 
empowered to alter any of the terms 
hereof, unless done in writing and signed 
by a duly authorized officer, employee or 
other representative of the respective 
parties. 

14. 	Should any part of this Agreement for any 
reason be declared invalid, such decision 
shall not affect the validity of any 
remaining portion, which remaining portion 
shall remain in force and effect as if this 
Agreement had been executed with the 
invalid portion thereof eliminated. And it is 
hereby declared the intention of the parties 
hereto that they would have executed the 
remaining portion of this Agreement 
without including therein any such part, 
parts, or portion which may, for any 
reason, be hereafter declared invalid. 

15. 	This Agreement shall be construed under 
the laws of the District of Columbia. Venue 
for any legal actions regarding this 
Agreement shall be in the District of 
Columbia. 

16. 	Statement of policy: The American Resort 
Development Association expects all 
members and others featured as authors 
or advertisers in ARDA publications, or 
exhibitors or speakers at ARDA meetings 
to be in full compliance with the ARDA 
Code of Standards & Ethics. The 
Association reserves the right to refuse 
publication of questionable articles or 
advertisements in any of its publications, 
to prohibit or remove from its trade shows 
whole exhibits or any exhibit merchandise 
or materials of any kind that raise any 
issues of ethics, and to refuse or cancel 
the appearance by any speaker 
determined to have advocated, been 
engaged in, or associated with unethical 
conduct. All authors, advertisers, exhibitors 
and speakers appearing in ARDA 
publications or meetings are hereby on 
notice of this policy and accept any 
invitations, agreements and contracts 
subject to it. As a consequence of this 
policy, all such persons or companies 
agree that their sole recourse against 
ARDA for any exclusion pursuant to this 
policy shall be refund of monies paid for 
advertising or exhibit space. Further, there 
shall be no claim for refund for exhibit 
space where exhibit materials or 
merchandise excluded was incidental to 
the purpose of the exhibit.  

Terms and conditions
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To secure your sponsorships call Bob Craycraft, VP Industry Relations at (202) 207-1079 or bcraycraft@arda.org.

ARDA sponsorships are notable for their success in recognizing 	
and branding the leaders in the timeshare, fractional ownership, 		
and private residence club industries.

Enjoy the recognition and returns of saturation-level promotion. 
ARDA sponsorships are your key to unlocking the vacation 
ownership industry.  

	 ARDA sponsorships offer the highest visibility 					   
	 opportunities focused directly at your target audience, 

the vacation ownership community.	

2012Sponsorship 
& Visibility Offerings

social events

trade shows

speakers & networking


